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Introducción 

 
 

El objetivo es desarrollar un tutorial para el aprendizaje de la cartografía digital, por 

medio de información local y el software CAD Microstation, que permita contribuir, 

con este recurso didáctico, a los análisis de los sistemas de información espacial. 

 
El presente trabajo pretende guiar al estudiante o a cualquier persona que 

independientemente quiera tener conocimientos iniciales de los sistemas de 

información geográfica, manejados desde una herramienta CAD (Computer Aided 

Desing), ya que en la actualidad la vieja cartografía en papel a sido sustituida por la 

cartografía digital por que es mucho mas fácil manipularla, es de mayor portabilidad 

y sobre todo ayuda a tomar decisiones acertadas con respecto a problemas reales, 

por lo que con el desarrollo de este trabajo se quiere apoyar al uso de una técnica y 

herramienta para el trabajo con mapas, por medio de un recurso didáctico para los 

estudiantes que cursan materias relacionadas con sistemas de información 

geográfica.  

 

La metodología utilizada de este trabajo se desarrolla por medio de un tutorial que 

esta dividido en 7 prácticas, las cuales son: 

 

La primera va a tratar temas que nos permita  familiarizarnos con la interfaz y 

controles principales del Microstation. 

 

La segunda realizaremos un inventario vial en la cual aprenderemos a crear un 

archivo, configurar unidades de trabajo, creación de niveles, ingreso de datos y 

consulta a una tabla. 

 

La tercera realizaremos un inventario de predios en la cual aprenderemos a utilizar 

herramientas de medición, crear niveles y reforzaremos lo aprendido en el capítulo 

1. 

 

La cuarta aprenderemos a crear células mediante un inventario de postes. 

 

La quinta realizaremos una práctica sobre como hacer dibujos de precisión.  
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La sexta aprenderemos sobre como unir dos o mas archivos de cartografía digital 

creando así un nuevo archivo de cartografía. 

 

La séptima que aprenderemos como crear un macro. 
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CAPITULO 1. INTRODUCCIÓN A  MICROSTATION V8.3. 

 
 

Ubicación temática. 
 
En esta práctica vamos a tratar temas que nos van permitir familiarizarnos con la 

interfaz y los controles principales para el manejo de la cartografía digital en 

Microstation, así mismo vamos a trabajar con elementos básicos como los que son 

los controles de vista que nos van a permitir manipular archivos .dgn. 

 
1.1 Interfaz y visualización de diseños. 
 
La interfaz va ser el medio de comunicación directo entre Microstation y los 

usuarios, es muy importante el buen manejo de la interfaz ya que dependerá de 

esto el buen funcionamiento de la herramienta CAD. 

 

1.1.1 Introducción de datos. 
 
Para introducir datos podemos utilizar el ratón y el teclado, ya sean datos 

numéricos, órdenes o textos, ya que en microstation el ratón será la mayor parte del 

tiempo el principal medio de comunicación con microstation a continuación se 

detallara algunas de las opciones existentes que nos da el mismo: 

 

• Reinicializar: Pulsando el botón derecho del ratón vamos a poder anular la 

orden de ejecución de un proceso en marcha, además también si un 

proceso consta de varios pasos vamos a poder regresar al paso anterior. 

• Datos: Para La introducción de datos es necesario pulsar el botón izquierdo 

del ratón ya sea para la dibujar un punto, una línea o cualquier polígono;  

para finalizar el misma se pulsara el botón derecho del ratón. 

• Pulsación: La pulsación del botón izquierdo es necesaria al momento de 

dibujar un polígono ya que esta finalizara la línea. 

• Tentativo: Se pulsa simultáneamente los botones derecho e izquierdo del 

ratón para hacer referencia posicional antes de ingresar un punto y además 

es útil para capturar puntos sobre elementos ya existentes.  
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Ahora vamos a abrir el archivo “TODO.dgn” para lo cual seguiremos el siguiente 

procedimiento, damos doble clic sobre el icono de microstation  en el cual se 

nos va a abrir la siguiente ventana: 

 

 
Figura 1.1: Abrir un archivo. 

 

Dicho archivo se encuentra en la carpeta “C:\Csig*\CARTO\” seleccionamos el 

archivo “TODO.dgn” y pulsamos el botón “aceptar” entonces senos va abrir el 

archivo. 

 

 
Figura 1.2: Ventana principal de microstation v8.3. 

 
 
1.1.2 Ventanas. 
 

En Microstation todas las ventanas “flotan” sobre el espacio plano, los controles y 

herramientas de Microstation están representadas por ventanas, las cuales 

explicaremos a continuación: 

 

• Ventana de comandos: Es la ventana principal y va a ser el centro de 

operaciones, la cual está ilustrada en la figura 1.3. 
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Figura 1.3: Ventana de microstation V8.3 ventana de comandos. 

 

• Vistas: Es el marco sobre el cual vamos a ver los diseños. 

• Casilla de Dialogo: Esta nos va a permitir ingresar diferentes tipos de 

comandos para poder realizar diseños más exactos, la cual esta ilustrada en 

la figura 1.4 y la podemos abrir de la siguiente manera escogemos de la 

barra de menús “Uilities” > “Key-in” y se nos abrirá la casilla. 
 

 
Figura 1.4: Casilla de Dialogo. 

 

• Paletas de herramientas: Figura 1.5 Es la ventana que nos va a permitir 

realizar nuestros diseños, dentro de una paleta pueden haber sub-paletas. 
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Figura 1.5: Paleta de Herramientas. 

 
1.2 Vista y controles de vista. 
 
1.2.1 Vista. 
 
Todas las herramientas de diseño de Microstation v8.3 van a estar actuando sobre 

un entorno “real” el cual va a ser simulado por el ordenador. A este entorno nos 

vamos a asomarnos a través de unas ventanas especiales llamadas vistas de modo 

que vamos a contemplar proporciones de un mismo diseño pero que van a tener 

diferentes ángulos, posiciones y factor de ampliación, como lo dijimos antes las 

vistas va a ser nuestro principal medio de interactividad con nuestro diseño.  

 

Una vez abierto el archivo denominado “TODO.dgn” podremos manipular las vistas 

ya sea con el ratón dando clic en los diferentes números de vistas las cuales están 

en la parte inferior de la ventana dependiendo de que vista sea la que queremos 

visualizar, y la segunda es mediante la barra de comandos, escribiendo los 

siguientes: 

 

• Abrir una vista: 

 

VIEW ON <número_ vista> 

 

• Cerrar una vista: 
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VIEW OFF <número_ vista> 

 

Para abrir la casilla de atributos de vista damos clic en la parte indicada en la Figura 

1.6 Atributos de vista, entonces se  nos va despegar una ventana flotante en la cual 

vamos a poder modificar los atributos de una vista a nuestra conveniencia. 

 

 

 

 

 
Figura 1.6: Atributos de vista. 

 
 
También vamos a poder gestionar las vistas desde la barra de menú seleccionando 

“window” > “views” como lo indica en la figura 1.7. 

 

 
Figura 1.7: Gestión de vistas. 

Número de Vistas 

Barra de Comandos 
 

Atributos de vista 
 

Barra de Menú 
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En la cual vamos a poder así mismo activar las vistas que necesitemos y poder 

ordenarlas ya sea en cascada o como más nos convenga para facilitarnos el 

trabajo. 

 

1.2.2 Controles de vista. 
 
Figura 1.8. Vamos a llamar controles de vista a las herramientas que nos van a 

permitir afectar el contenido de las vistas, a que escala y en que orientación vamos 

a trabajar, las cuales vamos a detallar a continuación siguiendo utilizando el archivo 

“TODO.dgn”: 

 

 
Figura 1.8: Controles de vista. 

 

•   Esta herramienta nos sirve para actualizar la vista actual en la que 

estemos trabajando. 
 

•  Estas herramientas nos sirven para aumentar la visualización y 

disminuir la visualización de una vista. 
 

•  Esta herramienta nos sirve para aumentar la visualización de una parte 

específica de un elemento.  
 

•  Esta herramienta sirve para darnos una vista total de los elementos en 

los cuales estamos trabajando. 
 

•  Esta herramienta nos sirve para mover la vista a nuestra conveniencia. 
 

•  Estas herramientas nos sirven para rehacer o deshacer los últimos 

cambios que se han realizado.  
 

•  Estas herramientas nos sirven para modificar la visualización 

de los elementos cuyos estamos trabajando. 
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1.3 Ejercicio de evaluación. 
 

• Abrir el Archivo “TODO.dgn” que se encuentra en la carpeta 

“C:\Csig*\CARTO\”  familiarizarse con las vistas y controles de vistas con 

entrada de teclado y con el ratón, además realizar en cada ejemplo una 

impresión de pantalla de cada  herramienta de controles de vista y pegarla 

en un archivo de Word detallando cada gráfico que práctica se a realizado, 

grabamos el archivo como Ejercicio_1. 
 

1.4 Conclusiones. 
 

Podemos decir que se puede utilizar los principales controles para la manipulación 

de archivos cartográficos en Microstation, ya que hemos utilizado los controles de 

vista que van a ser nuestro principal interfaz con la cartografía, así mismo nos 

hemos familiarizado con el entorno de Microstation. 
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CAPITULO 2. CREACIÓN DE ELEMENTO BÁSICO LÍNEAS A PARTIR DE 

CARTOGRAFÍA DIGITAL DE LA CIUDAD DE CUENCA: 
 
 
Ubicación temática. 
 
En esta práctica realizaremos una aplicación sobre un inventario de vías, el cual 

nos va a ayudar a aprender a crear un nuevo archivo, configurar las unidades de 

trabajo y de coordenadas, trabajar sobre archivos de referencia, creación de niveles 

y creación de tablas como también consultas de las mismas, además de como 

medir la longitud de una vía. 

 
2.1 Creación de un archivo DGN. 
 
Para utilizar indicar la creación de un elemento línea vamos a realizar un inventario 

vial sobre cartografía digital de La Ciudad de Cuenca en la cual vamos a seguir el 

siguiente procedimiento, primero vamos a abrir Microstation v8.3 dando doble clic 

sobre el icono  en donde se va a presentar un cuadro de dialogo en el cual 

vamos a crear un nuevo archivo de trabajo dando clic en el icono “New file” como 

se indica en la Figura 2.1. 

 

 
Figura 2.1: Creación de archivo .DGN. 

 

Procedemos a ingresar el nombre del archivo el cual lo vamos a llamar “Practica_2” 

y vamos a guardarlo en la siguiente dirección “C:\Csig*\CARTO\”, revisamos que el 

Tipo diga “MicroStation DGN Files (*.dgn)” y pulsamos el botón guardar.  
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Figura 2.2: Creación de archivo practica_2.dgn. 

 

Luego seleccionamos Practica_2 y pulsamos el botón abrir, se nos va a abrir el 

archivo en el cual vamos a realizar la práctica. 

 

 
Figura 2.3: Abrir Practica_2.dgn. 

 

2.2 Configuración de unidades de trabajo. 
 
Ahora vamos a proseguir con un paso fundamental antes de empezar cualquier 

práctica que es configurar las unidades de trabajo, las unidades de trabajo en las 

cuales vamos a trabajar van a ser los metros como unidad principal y como unidad 

auxiliar son los centímetros ya que estas son las más utilizadas en nuestro medio y 

las que manejamos en nuestra región; así mismo hay que configurar la resolución 

en que vamos a trabajar; es muy importante antes de empezar cualquier trabajo 

configurarlas como se va a indicar a continuación: 
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Figura 2.4: Configuración de unidades de trabajo. 

 

Nos vamos con el cursor a la barra de menú en la opción “Setting” luego damos un 

clic en “Desing File...”, luego en el menú “Category” señalamos con el cursor dando 

un clic en “Working Units” y en “Linear Units” cambiamos en  “Master Unit” Meters y 

en “Label” m, luego en “Sub Unit” seleccionamos “Centimeters” y en “Label” cm. 

 

 
Figura 2.5: Ventana archivo de diseño. 

 

En “Advanced Settings” pulsamos el botón “Edit” el cual nos va a mostrar un cuadro 

de dialogo de advertencia en el cual ponemos “Ok”, entonces se nos va a aparecer 

la ventana que está ilustrada en el gráfico en la parte inferior y en “Resolution” 

cambiamos a “100 per Meter” luego damos un clic en “Ok” y en “Ok” y así vamos a 

configurar las unidades de trabajo y la resolución que vamos a trabajar de ahora en 

adelante, por eso es importante de que antes de empezar cualquier tipo de trabajo 

primero cambiar a este tipo de configuración. 
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Figura 2.6: Cambio de unidades avanzadas. 

 

Para que quede grabada nuestra nueva configuración es de vital importancia seguir 

el siguiente procedimiento el cual es señalar con el cursor en la barra de menú, 

“File” > “Save Settings”, si no hacemos este último procedimiento nuestros cambios 

no van a quedar grabados. 

 

 
Figura 2.7: Grabar cambios. 

 

2.3 Sistemas de coordenadas. 
 
El sistema de coordenadas en los cuales vamos a trabajar en elementos 2D es el 

sistema de coordenadas rectangulares ya que va a ser mas que suficiente además 

que si trabajamos con el sistema de coordenadas polares la brújula nos va a servir 

nada más como un indicador, en el momento que trabajemos con elementos tipo 

3D nos va ser de mucha más utilidad ya que vamos a trabajar con ángulos. 

 

 
En el sistema de coordenadas en el cual estamos trabajando en la actualidad va a 

ser reflejada en la barra inferior de la ventana de Microstation v8.3 y podemos 

cambiar ya sea a rectangular o a polar según el caso lo amerite posicionándonos 

sobre ella y aplastamos la tecla espaciadora. 
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Figura 2.8: Sistema de coordenadas. 

 

2.4 Archivos de referencia. 
 
Una vez configurada las unidades de trabajo vamos a traer el archivo referencial el 

cual es la cartografía digital de Cuenca que se encuentra en la siguiente dirección 

C:\Csig*\CARTO\TODO de la siguiente manera seleccionamos de la Barra de Menú 

“File” > “Reference” en el cual se nos va a presentar la siguiente ventana. 

 

 
Figura 2.9: Archivos de referencia. 

 

En la Figura2.9 seleccionamos en está ventana “Tools” > “attach…” damos un clic 

en “TODO” y abrimos, luego pulsamos en “Ok” entonces el archivo “TODO.dgn” va 

a aparecer pero solo como archivo de referencia, para poder trabajar sobre el 

damos clic sobre “fit view”  en los controles de vista para poder ver al archivo de 

referencia como lo vamos a ver en la Figura 2.10 
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Figura 2.10: Archivo de referencia TODO.dgn 

 

Procedemos ahora a trabajar sobre el centro de la ciudad por lo que con la 

herramienta “zoom”  nos posicionamos sobre las calles Gran Colombia y Padre 

Aguirre para trabajar sobre el Inventario Vial, 

 

2.5 Creación de niveles. 
 

El paso siguiente que vamos a seguir es crear un nivel para poder graficar las calles 

lo cual vamos seguir el siguiente procedimiento escogemos de la barra de menú 

“Settings” > “level” > “manager” se nos va abrir la siguiente venta que observamos 

en la figura 2.11 

 

 
Figura 2.11: Creación de un nivel. 
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De esta ventana escogemos “Levels > New” y nombramos a al nuevo nivel 

“Pract_calles” seleccionamos el color 50, diseño de línea que escogemos la misma 

y el grosor de la línea que escogemos 2  y cerramos dicha ventana con esto va a 

quedar creado un nuevo nivel como se muestra en la figura 2.12. 

 

 
Figura 2.12: Creación de un nuevo nivel. 

 

Luego vamos a seleccionar en la barra de Niveles el nivel recién creado y en los 

atributos de elementos vamos a seleccionar “By Label” con lo cual hacemos que 

automáticamente en el momento que seleccionemos con el nivel que deseemos 

trabajar, los atributos cambien también a los atributos del nivel seleccionado como 

se muestra a continuación: 

 

    
Figura 2.13: Selección de nivel. 

 

2.6 Herramienta smartline. 
 

Para empezar ya a dibujar nuestras calles vamos a seleccionar de la paleta de  

Herramientas la herramienta “Smartline” , esta herramienta nos va a servir para 

poner un elemento complejo; es decir un conjunto de líneas desde una línea recta, 

curva, polígono o una combinación de las mismas. 
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Figura 2.14: Herramienta smartline. 

 
Tipo de segmento: Va definir el tipo de segmento y va a configurar el segmento de 

línea o el segmento de arco. 

 
Tipo de vértice: El tipo de vértice que puede ser agudo, redondeado o 

achaflanado. 

 

Radio del arco: Va a definir el radio de un arco de un vértice redondeado. 

  

Una vez escogida la herramienta vamos a dejar las opciones de esta en default. 

 

2.7 Dibujar calles. 
 

La primera calle que vamos a construir es la calle Gran Colombia entre Calle Quinta 

y Padre Aguirre dando un clic izquierdo en la esquina de la calle y seguimos con el 

ratón hasta la otra esquina que damos otro clic izquierdo, para finalizar la 

construcción de la línea damos un clic con el botón derecho del ratón y va a quedar 

como se muestra en la figura 2.15. 

 

Unir 
Elementos 

Rotar AccDraw 
hacia elementos 

Empezar siempre 
en modo línea 
 

Smartline 
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Figura 2.15: Construcción de una vía. 

 

De la misma manera seguimos construyendo las siguientes calles pero debemos 

tomar en cuenta que en el momento de construir las líneas, queden unidas 

verificando con el siguiente indicador, que es que el puntero del ratón que cambia al 

momento que quedan unidas las líneas que a continuación mostramos. 

  

 

 
Figura 2.16: Indicador de unión entre líneas 

 

Seguimos construyendo hasta que nos queden las calles dibujadas de la siguiente 

manera como se muestra en la Figura 2.17 
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Figura 2.17: Vías construidas. 

 

2.8 Creación de una tabla. 
 

Para proceder con la práctica ahora vamos a crear una tabla en la cual vamos a 

ingresar los datos de las calles, como es un ejemplo vamos a simular que entre las 

calles dibujadas vamos a tener los siguientes atributos de la tabla Inv_vial: 

 

Nombre Atributo Tipo Descripción 

Cod_via Integer Numeración secuencial 

Nombre_via Character Primeras tres letras 
nombre vía, seguido por 

número Eje. COL001 
Entre Character Primeras tres letras 

nombre vía, seguido por 
número Eje. COL001 

Y Character Primeras tres letras 
nombre vía, seguido por 

número Eje. COL001 
Tipo Character Asfalto(A), Tierra(T) o de 

Cemento(C) 
Longitud Real Medición mediante 

herramienta  
Estado Character Bueno(B), Malo(M), 

Regular(R) 
Tabla 2.1: Diccionario de datos tabla “Inv_vial”. 

 

Para crear la tabla vamos a seleccionar de la barra de menú “element > tags > 

define”, en el cual va a aparecer la siguiente ventana como se muestra en la figura 

2.18 
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Figura 2.18: Creación tabla. 

 

En donde vamos a pulsar el botón “Add” en “Sets” y ponemos como nombre 

“Inv_vial” luego vamos a agregar los atributos de la tabla en “Add” en “Tags” y 

vamos a ir creando los atributos de la tabla de la siguiente manera: 

 

 
Figura 2.19: Creación de atributos. 

 
En “Tag name” ponemos el nombre del atributo, en “Prompt” ponemos la 

descripción de que tenemos que ingresar, en “Type” el tipo de valor a ingresar y 

quitamos el “Check” en “Display Tag” como se muestra en la figura 2.19, luego 

continuamos con el resto de atributos de la tabla “Nombre de la vía”, “Entre” e “Y”, 

el “Tipo”, “longitud” de la calle que lo dejaremos al último ya que se utilizara una 

herramienta de medición, y el “Estado”. 
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Figura 2.20: Ingreso de atributos. 

  

2.9 Ingreso de datos en una tabla. 
 

Para empezar a ingresar los datos vamos a seleccionar de la paleta de 

herramientas la herramienta “Atach Tags”  y vamos a seleccionar la vía dando 

un clic de la siguiente manera como se indica a continuación en la Figura 2.21: 

 
Figura 2.21: Selección de vía. 

 

Se nos va a abrir la siguiente ventana en la cual empezaremos a ingresar los datos 

de las vías, como es un ejemplo vamos a simular que este tramo de la calle es 

asfalto, la longitud la vamos a ingresar luego con una herramienta de medición y 

ponemos en “Ok”. 
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Figura 2.22: Ingreso de datos. 

 

Una vez ingresado los datos de las otras vías vamos a ingresar la longitud por vía y 

vamos a utilizar de la paleta de herramientas la herramienta “Measure Length” , 

entonces vamos a seleccionar una vía que puede ser la “COL001” y en la parte de 

abajo de la ventana de Microstation v8.3 automáticamente aparecerá la longitud 

como se muestra en la figura 2.23 

 

 
Figura 2.23: Largo de una vía. 

 

Cuando tengamos la longitud de la vía utilizaremos la herramienta “Edit Tags”  y 

volveremos a seleccionar la vía “COL001” en donde vamos a ingresar la longitud, 

para que se facilite el procedimiento podemos copiar la longitud del cuadro de 

dialogo de la herramienta “Measure Length”. 

 

 
Figura 2.24: Longitud vial. 

 

Y seleccionamos con la herramienta “Edit Tags”  de la vía y pegamos la longitud, 

una vez acabado de llenar el campo de “Longitud” de todas las vías vamos a 

realizar consultas. 
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2.10 Consultas de una tabla. 
 

Para realizar una consulta seleccionamos de la barra de menú “Edit > Select by > 

Attributes” en donde se nos va abrir la siguiente ventana en la cual vamos a 

seleccionar “Tags”. 

 

 
Figura 2.25: Selección de vías por atributos. 

 

Con lo que se despliega la ventana donde vamos a realizar la siguiente consulta, 

seleccione, que sean de Tierra y que el “Estado” de la vía sea regular. 

 

 
Figura 2.26: Selección por atributos. 

 

Luego cerramos la ventana y damos clic en “execute”, entonces vamos a poder ver 

las vías correspondientes en este caso las siguientes. 
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Figura 2.27: Consulta realizada. 

 
2.11 Ejercicio de evaluación. 
 

• Crear un archivo llamado Ejercicio_2.dgn y realizar un Inventario vial de la 

zona de la Av. Remigio Crespo utilizando como archivo de referencia la 

cartografía digital de la ciudad de Cuenca que se encuentra en TODO.dgn 

ubicado en la siguiente dirección C:\Csig*\CARTO . 

• Realizar el ingreso de atributos, “Longitud” con las herramientas indicadas 

en la práctica y realizar las diferentes consultas. 

• Al final de la práctica realizar una impresión de al menos cuatro diferentes 

consultas realizadas y pegarlas en un documento de Word con el nombre de 

Ejercicio_2. 

 

2.12 Conclusiones. 
 
Hemos podido utilizar, con el ejemplo de inventario vial, las herramientas para crear 

un nuevo archivo, configurando las unidades de trabajo y el sistemas de 

coordenadas más óptimo para el manejo de cartografía, así también como trabajar 

con archivos de referencia, creación de niveles, tablas, ingreso de atributos con 

herramientas de medición y la realización de consultas. 
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CAPITULO 3.  INVENTARIO DE PREDIOS A PARTIR DE CARTOGRAFÍA 

DIGITAL DE UN SECTOR DE LA CIUDAD DE CUENCA. 
 
 
Ubicación temática. 
 
En esta práctica vamos a realizar una aplicación sobre un inventario de predios 

utilizando las herramientas para crear un nuevo archivo, trabajar sobre archivos de 

referencia, creación de niveles y creación de tablas como también consultas de las 

mismas además como medir la superficie de un terreno. 

 
3.1 Creación del archivo Practica_3. 

Abrimos Microstation v8.3 dando doble clic sobre el icono  en donde se va a 

presentar un cuadro de dialogo en el cual vamos a crear un nuevo archivo de 

trabajo dando clic en el icono “New file” como se indica en la Figura 3.1 

 

 
Figura 3.1: Creación de archivo Practica_3.dgn. 

 

Procedemos a ingresar el nombre del archivo el cual lo vamos a llamar “Practica_3” 

y vamos a guardarlo en la siguiente dirección “C:\Csig*\CARTO\”, revisamos que el 

“Tipo” diga “MicroStation DGN Files (*.dgn)” y pulsamos el botón “Guardar”.  
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Figura 3.2: Creación de archivo “Practica_3.dgn”. 

 

Luego seleccionamos “Practica_3” y pulsamos el botón “Abrir”, se nos va a abrir el 

archivo en el cual vamos a realizar la práctica. 

 

 
Figura 3.3: Abrir Practica_3.dgn. 

 

3.2 Configuración de las unidades de trabajo. 
 

Entonces vamos a proceder a configurar las unidades de trabajo como paso 

principal antes de comenzar cualquier trabajo. 
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Figura 3.4: Configuración de unidades de trabajo. 

 

Nos vamos con el cursor a la barra de menú en la opción “Setting   >  Desing File...” 

Luego en el menú “Category” señalamos con el cursor dando un clic en “Working 

Units” y en “Linear Units” cambiamos en  “Master Unit” “Meters” y en “Label” “m”, 

luego en “Sub Unit” seleccionamos “Centimeters” y en “Label”  “cm”. 

 
Figura 3.5: Ventana archivo de diseño. 

 

En “Advanced Settings” pulsamos el botón “Edit” el cual nos va a mostrar un cuadro 

de dialogo de advertencia en el cual ponemos “Ok”, entonces se nos va a aparecer 

la ventana que está ilustrada en la figura de la parte inferior, en “Resolution” 

cambiamos a “100 per Meter” luego damos un clic en “Ok” y en “Ok” y así vamos a 

configurar las unidades de trabajo y la resolución que vamos a trabajar de ahora en 

adelante, por eso es importante de que antes de empezar cualquier tipo de trabajo 

primero cambiar a este tipo de configuración. 
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Figura 3.6: Cambio de unidades avanzadas. 

 

Como lo indicamos en el anterior capítulo es de mucha importancia grabar los 

cambios realizados de la siguiente manera en la Barra de Menú seleccionamos 

“File > Save Settings”.  

 

 
Figura 3.7: Grabar cambios. 

 

3.3 Sistemas de coordenadas. 
 

Revisamos que el sistema de coordenadas en el cual vamos a trabajar es el de 2D 

en la Barra de Sistemas de Coordenadas. 

 

 
Figura 3.8: Sistema de coordenadas. 

 

3.4 Traer un archivo de referencia. 
 
Una vez configurada las unidades de trabajo vamos a traer el archivo referencial el 

cual es un tramo de la cartografía digital de Cuenca que se encuentra en la 

siguiente dirección “C:\Csig*\CARTO” de la siguiente manera seleccionamos de la 
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barra de menú “File > Reference” en el cual se nos va a presentar la siguiente 

ventana. 

 

 
Figura 3.9: Archivos de referencia. 

 

En la Figura3.9 seleccionamos en está ventana “Tools > attach…” damos un clic en 

“C*” y abrimos, luego pulsamos en “Ok” entonces el archivo “C*.dgn va a aparecer 

pero solo como archivo de referencia, para poder trabajar sobre el damos clic sobre 

fit view  en los controles de vista para poder ver al archivo de referencia como lo 

vamos a ver en la Figura 3.10. 

 

 
Figura 3.10: Archivo de referencia C*.dgn 
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Entonces ahora vamos a trabajar sobre los predios de la Calle Galápagos por lo 

que con la herramienta zoom  nos posicionamos sobre el dicho sector para 

trabajar en el Inventario Predial. 

 

3.5 Creación de un nuevo nivel. 
 

El paso siguiente que vamos a seguir es crear un nivel para poder graficar los 

predios lo cual vamos seguir el siguiente procedimiento escogemos de la barra de 

menú “Settings > Level > Manager” se nos va abrir la siguiente venta que 

observamos en la Figura 3.11. 

 

 
Figura 3.11: Creación de un nivel. 

 

De esta ventana escogemos “Levels > New” y nombramos a el nuevo nivel 

“Pract_predios” seleccionamos el color 1, diseño de línea que escogemos la misma 

y el grosor de la línea que escogemos 3  y cerramos dicha ventana con esto va a 

quedar creado un nuevo nivel como se muestra en la figura 3.12. 

 

 
Figura 3.12: Creación de un nuevo nivel. 
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Luego vamos a seleccionar en la barra de niveles el nivel recién creado y en los 

atributos de elementos vamos a seleccionar “By Label” con lo cual hacemos que 

automáticamente en el momento que seleccionemos con el nivel que deseemos 

trabajar los atributos cambien también a los atributos del nivel seleccionado como 

se muestra a continuación: 

 

    
Figura 3.13: Selección de nivel. 

 

3.6 Selección de herramienta smartline. 
 

Para empezar ya a dibujar nuestros predios vamos a seleccionar de la paleta de  

Herramientas la herramienta “Smartline” , esta herramienta nos va a servir para 

poner un elemento complejo; es decir un conjunto de líneas desde una línea recta, 

curva, polígono o una combinación de las mismas. 

 

 
Figura 3.14 Herramienta smartline. 

 
Tipo de segmento: Va definir el tipo de segmento y va a configurar el segmento de 

línea o el segmento de arco. 

 
Tipo de vértice: El tipo de vértice que puede ser agudo, redondeado o 

achaflanado. 

 

Radio del arco: Va a definir el radio de un arco de un vértice redondeado. 

 

 

Unir 
Elementos 

Rotar AccDraw 
hacia elementos 

Empezar siempre 
en modo línea 
 

Smartline 
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3.7 Creación de un predio. 
  

Una vez escogida la herramienta vamos a dejar las opciones de está en default y 

empezamos a dibujar los predios como en la figura 3.15, Damos un clic con el 

botón izquierdo en un lote y continuamos dando clic derecho rodeando el lote hasta 

que quede cerrarlo por completo, para finalizar el polígono lo cerramos dando un 

clic derecho donde se una el polígono. 

 

 
Figura 3.15: Construcción de una vía. 

 

Es importante que todos los polígonos queden unidos completamente, para saber 

esto el ratón cambia de puntero cuando se unen las líneas como el la figura 3.15, 

se explicara dibujando el siguiente predio. 
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Figura 3.16: Unión de un polígono. 

 

Si queremos eliminar el polígono completo vamos a utilizar la siguiente 

herramienta , con la cual damos un clic izquierdo al polígono a eliminar y se nos 

eliminara, si un polígono por error no se cierra por completo podemos utilizar la 

siguiente herramienta llamada “Modify Element”  , la cual nos va a permitir 

modificar el elemento y poder unir el polígono como lo vamos a explicar a 

continuación dibujando el siguiente predio. 

 

 
Figura 3.17: Utilización de la herramienta Modify Element. 

 

Como podemos observar en la figura 3.16 que el polígono no quedo cerrado por 

completo vamos a seleccionar la herramienta “Modify Element” y señalamos el 

polígono a modificar de la siguiente manera como en la figura 3.17.  
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Figura 3.18 Utilización de la herramienta Modify Element. 

 
Entonces ahí vamos a poder modificar el polígono y lo vamos a poder cerrar por 

completo y nos vamos a dar cuenta que el polígono esta cerrado por completo ya 

que el puntero cambiara y daremos un clic izquierdo para cerrarlo como se muestra 

a continuación. 

 

 

 
Figura 3.19: Unión de un polígono. 

 

Bueno, entonces seguiremos dibujando los siguientes predios hasta que quede de 

la siguiente manera. 

 

 
Figura 3.20: Lotes construidos. 
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Ahora vamos a crear un punto en el cual vamos a asignar la información del predio 

por lo que escogemos la herramienta “Place Active Point”  . 

 

 
Figura 3.21: Herramienta Place Active Point. 

 

Con lo cual vamos a escoger un grosor de 15 y vamos a ir asignando un punto en 

cada predio de la siguiente manera. 

 

 
Figura 3.22: Asignar un punto a cada lote. 
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3.8 Creación de una tabla. 
  

Para proceder con la práctica ahora vamos a crear una Tabla en la cual vamos a 

ingresar los datos de los predios, como es un ejemplo vamos a simular que algunos 

de los predios dibujados vas a ser desocupados para nuestra tabla vamos a tener 

los siguientes atributos de la tabla Inv_predios: 

 

Nombre Atributo Tipo Descripción 

Ced_propietario Integer Cedula persona 

propietaria 

Nom_propietario Character Nombre persona 

propietaria 

Habitantes Integer Número de Habitantes 

Tipo Character Casa(C), Edificio(E) 

Terreno Character Baldío(B), 

Construcción(C), 

Terminado(T), 

Agua Character S/N 

Luz Character S/N 

Telefono Integer S/N 

Superficie Real Medición mediante 

herramienta 

Tabla 3.1: Diccionario de datos tabla “Inv_predios”. 
 

Para crear la tabla vamos a seleccionar de la barra de menú “Element > Tags > 

Define”, en el cual va a aparecer la siguiente ventana como se muestra en la figura 

3.23. 

 

 
Figura 3.23: Creación de una tabla. 
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En donde vamos a pulsar el botón “Add” en “Sets” y ponemos como nombre 

“Inv_lotes” luego vamos a agregar los atributos de la tabla en “Add” en “Tags” y 

vamos a ir creando los atributos de la tabla de la siguiente manera: 

 

 
Figura 3.24: Creación de atributos. 

 
En “Tag Name” ponemos en el nombre del atributo en “Prompt” ponemos una 

descripción de que tenemos que ingresar, en “Type” el tipo de valor a ingresar y 

quitamos el “Check” en “Display Tag” como se muestra en la figura 3.24, luego 

continuamos el ingreso con el resto de atributos de la tabla. 

 

3.9 Ingreso de datos a una tabla. 
 

Para empezar a ingresar los datos vamos a seleccionar de la paleta de 

herramientas la herramienta “Atach Tags”  y vamos a seleccionar el punto en el 

cual colocamos para el ingreso de información de cada predio dando un clic de la 

siguiente manera como se indica a continuación en la Figura 3.25: 
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Figura 3.25: Selección de lote. 

 

Se nos va a abrir la siguiente ventana en la cual empezaremos a ingresar los datos 

de los predios, como es un ejemplo vamos a simular que este predio es terminado, 

la superficie la vamos a ingresar luego con una herramienta de medición y ponemos 

en Ok. 

  

 
Figura 3.26: Ingreso de datos. 

 

Una vez ingresado los datos de las otros predios vamos a ingresar la superficie por 

predio y vamos a utilizar de la paleta de herramientas la herramienta “Measure 

Área” , entonces vamos a seleccionar un predio y en la parte de abajo de la 

ventana de Microstation v8.3 automáticamente aparecerá la superficie como 

también el perímetro como se muestra en la figura 3.27 

 
Figura 3.27: Superficie de un predio. 
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Cuando tengamos la superficie del predio vamos a utilizar la herramienta “Edit 

Tags”  y volveremos a seleccionar el predio en donde vamos a ingresar la 

superficie. 

Para que se facilite el procedimiento podemos copiar la superficie del cuadro de 

dialogo de la herramienta “Measure Área”. 

 

 
Figura 3.28: Área del predio. 

 

Y seleccionamos con la herramienta Edit Tags  el predio y pegamos la 

superficie, una vez acabado de llenar el campo de superficie de todos los lotes 

vamos a realizar consultas. 

 

3.10 Consultas de una tabla. 
 

Seleccionando de la barra de menú “Edit > Select by Attributes” en donde se nos va 

abrir la siguiente ventana en la cual vamos a seleccionar “Tags”. 
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Figura 3.29: Selección de lotes por atributos. 

 

Con lo que se despliega la ventana donde vamos a realizar la siguiente consulta, 

seleccione los predios donde falte el servicio de agua. 

 
Figura 3.28: Selección por atributos. 

 

Luego cerramos la ventana y damos clic en execute, entonces vamos a poder ver 

los predios correspondientes en este caso las siguientes. 
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Figura 3.30: Consulta realizada. 

 

3.11 Ejercicio de evaluación. 
 

• Crear un archivo de trabajo y llamarlo Ejercicio_3.dgn y realizar un 

inventario de predio utilizando como archivo de referencia la cartografía 

digital de un tramo de la ciudad de Cuenca que se encuentra en C*.dgn 

ubicado en la siguiente dirección C:\Csig*\CARTO. 

• Realizar el ingreso de Atributos, Superficie con las herramientas indicadas 

en la práctica y realizar las diferentes consultas. 

• Al final de la práctica realizar una impresión de al menos cuatro diferentes 

consultas realizadas y pegarlas en un documento de Word con el nombre de 

Ejercicio_3. 

 

3.12 Conclusiones. 
 
Lo relevante de este capítulo podríamos decir que nos familiarizamos más con el 

entorno de Microstation, con los controles de vista, así como también a la 

manipulación de un archivo DGN, aprendimos a medir superficie y perímetro, y 

reforzamos los conocimientos aprendidos en el Capítulo 2. 
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CAPITULO 4. INVENTARIO DE POSTES A PARTIR DE CARTOGRAFÍA DIGITAL 

DE UN SECTOR DE LA CIUDAD DE CUENCA. 
 

 

Ubicación temática. 
 
El objetivo de esta práctica es aprender el concepto de células y la creación y 

manipulación de las mismas, creación de un nuevo archivo de trabajo, configurar 

unidades de trabajo, trabajar con archivos de referencia y el manejo de tablas. 

 

4.1 Células. 
 
Se podría decir que una célula es un dibujo pequeño y se la va a utilizar cuando se 

necesite utilizar un símbolo o notación con mucha frecuencia, las células se van a 

ser almacenadas en una archivo DGN el cual es llamado biblioteca de células y 

podrá contener muchas células, como ejemplo de células podemos mostrar los 

siguientes: 

 

 
Figura 4.1: Ejemplos de células para cartografía. 

 
4.2 Creación de un archivo DGN. 
 

Primero vamos abrir Microstation v8.3 dando doble clic sobre el icono  el cual nos 

va a presentar la siguiente ventana: 
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Figura 4.2: Creación de un archivo DGN.  

En la cual vamos a dar clic en el icono de “New File” el cual nos va a desplegar otra 

ventana: 

 

 
Figura 4.3: Creación de archivo DGN. 

 

Entonces vamos a poner el nombre de esta práctica como “Practica_4”, en “Tipo” 

nos fijamos que este “MicroStation DGN Files (*.dgn)” y en “Seed” la ubicación en la 

cual vamos a guardar nuestro archivo y pulsamos el botón “Guardar” luego 

seleccionamos el archivo “Practica_4” y pulsamos en el botón “Abrir”. 

 

4.3 Configuración de las unidades de trabajo. 
 
Seleccionamos de la barra de menú “Settings > Desing File…” y se nos va abrir la 

siguiente ventana en la cual seleccionamos “Working Units”. 
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Figura 4.4: Configuración de unidades de trabajo. 

 

En “Master Unit” verificamos que este en “Meters” y en “Label” “m”. “Sub Unit” 

verificamos que este en “centimeters” y en “Label” “cm.” si no lo esta lo cambiamos 

y en “Advanced Settings” damos un clic en el botón de “Edit” y pulsamos “Ok” y se 

va a parecer la siguiente ventana en la cual cambamos “100 por metro”. 

 

 
Figura 4.5: Configuración de unidades avanzadas. 

 

Y pulsamos en “Ok” y en “Ok”, luego escogemos de la barra de menú “File > Save 

Settings” con lo cual vamos a dejar configuradas las unidades de trabajo sobre las 

cuales vamos a trabajar en nuestro documento; es importante que sigamos este 

procedimiento siempre antes de empezar a trabajar. 

 

4.4 Archivos de referencia. 
 

Para poder trabajar sobre un inventario de postes vamos a traer como un archivo 

solo como de referencia a un tramo de la cartografía digital de Cuenca para lo cual 

escogemos de la barra de menú “File > Reference” y de la ventana que se 

despliega seleccionamos “Tools > Attach” como se muestra en la Figura 4.6. 
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Figura 4.6: Archivos de referencia. 

 

Y seleccionamos el siguiente archivo C*.dgn y pulsamos en el botón Abrir y luego 

pulsamos el botón Ok y cerramos la ventana, con la herramienta “Fit View”   nos 

posicionamos sobre el archivo de referencia y con la herramienta “Zoom” podemos 

hacer un acercamiento. 

 

 
 
4.5 Creación de una célula. 
 
Nos vamos a posicionar sobre una parte en blanco de la interfaz de Microstation. 

 

 
Figura 4.7: Creación de una célula. 
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Luego vamos a seleccionar en la paleta de herramientas con un clic “Drawing”. 

 

  
Figura 4.8: Selección de herramienta. 

 

Y seleccionamos la herramienta “Place Circles”  dejamos todos las opciones de 

esta herramienta en Default menos el diámetro que lo pondremos en 3  y en la 

barra de nivel vamos a escoger para este ejemplo color 3 que equivale a rojo y el 

grosor de la línea 1 y vamos a colocar el circulo dando un clic izquierdo luego un 

derecho. 

 

 
Figura 4.9: Graficar un circulo. 

Entonces para continuar con la creación de la célula vamos a involucrar la entidad 

en un cercado utilizando la herramienta “Place Fence”  con la cual vamos a 

rodear la entidad de la siguiente manera. 
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Figura 4.10: Cercado de una entidad. 

  

Luego de cercar la entidad vamos a continuar con el procedimiento definiendo un 

origen con la herramienta “Define Cell Origen”. 

 

 
Figura 4.11: Definición de origen de célula. 

 

Y seleccionamos en el centro del círculo como se muestra a continuación y damos 

un clic. 

 

 
Figura 4.12: Origen de célula. 

 

Después de haber definido el origen de la célula vamos vincular a un archivo DGN, 

seleccionando de la barra de menú de Microstation “Element > Cell” donde se nos 

va a desplegar la siguiente ventana. 
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Figura 4.13: Librería de células. 

 

 

De esta ventana seleccionamos “File > Attach File…" y nos vamos al directorio 

“C:\DocumentsandSettings\AllUsers\DatosdePrograma\Bentley\WorkSpace\System\

Cell”; y seleccionamos “archpa” y damos un clic en abrir.  

 

 
Figura 4.14: Vincular librería de células. 

 

Luego damos un clic en “Create” y ponemos el nombre de la célula y una 

descripción y damos un clic en “Create” y cerramos la ventana por lo que queda 

grabada la célula. 

 

 
Figura 4.15: Crear nueva célula. 

 

Luego vamos a crear dos células más para que representen postes de cemento y 

de hormigón, ahora vamos a crear una célula para representar postes de hormigón 

por lo que vamos a seleccionar la herramienta “Place Block”  . 
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Figura 4.16: Herramienta Place Block. 

 

Una vez seleccionada la herramienta vamos a seleccionar otro color como por 

ejemplo el color 1, entonces damos un clic en una parte en blanco de la ventana de 

microstation y en la herramienta “Key-in” vamos a ingresar el siguiente comando 

que nos va a dar las dimensiones de la nueva célula, que se puede apreciar en la 

figura 4.17. 

 

 
Figura 4.17: Dimensiones de nueva célula de postes de hormigón. 

 

Con lo cual la nueva célula va a quedar de la siguiente manera. 

 

 
Figura 4.18: Célula creada. 

 

Y vamos a seguir el mismo procedimiento que hicimos con la creación de la anterior 

célula que era la de postes de madera, primero vamos a cercar la entidad. 
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Figura 4.19: Cercado de una entidad. 

 

 

Ahora vamos a definir el origen del elemento con la herramienta “Define Cell 

Origen”  . 

 
Figura 4.20: Definición del origen del elemento. 

 

Después de haber definido el origen de la célula vamos vincular a un archivo DGN, 

seleccionando de la barra de menú de Microstation “Element > Cell” donde se nos 

va a desplegar la siguiente ventana. 
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Figura 4.21: Librería de células. 

 

 

De esta ventana seleccionamos “File > Attach File…" y nos vamos al directorio 

“C:\DocumentsandSettings\AllUsers\DatosdePrograma\Bentley\WorkSpace\System\

Cell”; y seleccionamos “archpa” y damos un clic en abrir.  

 

 
Figura 4.22: Vincular librería de células. 

Luego damos un clic en “Create” y ponemos el nombre de la célula y una 

descripción y damos un clic en “Create” y cerramos la ventana por lo que queda 

grabada la célula. 

 

 
Figura 4.23: Crear nueva célula. 

 
Ahora vamos a crear una célula que represente postes de cemento por lo que 

vamos a utilizar la herramienta “smartline” y vamos a crear otra figura geométrica 

que lo represente como un triangulo y seguimos el mismo procedimiento de 

creación de las anteriores células; es decir, cercar a la entidad, definir un origen, 

vincular a la misma librería de células, luego la ponemos nombre y descripción. 
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4.6 Ingreso de células en el archivo. 
 
Seleccionamos de las herramientas “Place Active Cell”. 

 

 
Figura 4.24: Herramienta Place Active Cell. 

 
Entonces en las opciones de esta herramienta vamos a buscar la célula creada. 

 

 
Figura 4.25: Buscar célula. 

Buscamos la célula “Postes de madera” y damos doble clic sobre ella cerramos la 

ventana y empezamos a poner los postes alrededor de la siguiente cuadra dando 

un clic izquierdo y terminamos dando un clic derecho, así mismo lo vamos a poner 

los postes de hormigón y de cemento. 

 

 
Figura 4.26: Ingreso de postes. 
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4.7 Creación de una tabla. 
 
Ahora vamos a crear una tabla de la siguiente manera seleccionamos del menú 

“Element > Tags > Define”. 

 

 
Figura 4.27: Definición de tablas. 

 

En “Sets” damos un clic en el botón “Add” y ponemos como nombre a la tabla 

“Inv_postes” y damos un clic en “Ok” luego en “Tags” damos un clic en “Add” e 

ingresamos los atributos de la tabla que serán los siguientes. 

 

Nombre Atributo Tipo Descripción 

Cod_poste Character Primeras tres letras 

nombre vía, seguido por 

número Eje. COL001 

Calle_pri Character Nombre calle 

Calle_sec Character Nombre calle 

Estado Character Bueno(B), Malo(M), 

Regular(R) 

Tabla 4.1: Diccionario de datos tabla “Inv_postes”. 
 

 Quitamos el check en “Display Tag” y damos un clic en “Ok”. 

 

 
Figura 4.28: Ingreso de datos. 
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Luego continuamos ingresando los siguientes atributos de la tabla. 

 

4.8 Ingreso de datos a una tabla. 
 
Para el ingreso de información a una tabla vamos a seguir el siguiente 

procedimiento escogemos de la paleta de herramientas la herramienta “Attach 

Tags”  con la cual vamos a señalar el primer poste de la siguiente manera. 

 

 
Figura 4.29: Selección de poste ingreso de información. 

 

En la cual se nos va a desplegar el siguiente cuadro e introduciremos la información 

de dicho poste como esto es una simulación vamos a ingresar el estado de los 

postes a nuestro criterio pero los demás atributos se ingresaran correctamente, 

luego una vez ingresada la información damos clic en “Ok”. 

 

 
Figura 4.30: Ingreso de información. 
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Y así continuamos con el ingreso de la información de los siguientes postes.  

 

4.9 Consulta de datos. 
 

Para la consulta de datos escogemos del menú “Edit > Select by Attributes” en el de 

la siguiente ventana pulsamos el botón “Tags”, y vamos a realizar la siguiente 

consulta que seleccione todos los postes de la “Av. Remigio Crespo” como calle 

principal que se encuentren en mal estado, para esto hacemos la siguiente 

selección. 

 

 

 

 
Figura 4.31 Consulta de información. 

 

Entonces pulsamos en el botón “Insert” e ingresamos la siguiente comparación, 

cerramos la ventana y luego pulsamos en el botón “Execute”. 

 



 56 

 
Figura 4.24 Postes en mal estado. 

 

Entonces vamos a poder ver que en la Av. Remigio Crespo se encuentran dos 

postes en mal estado y el uno es de madera y el otro de cemento. 

 

4.10 Ejercicio de evaluación. 
 

• Crear un archivo “DGN” llamado Ejercicio_4 y realizar un Inventario de 

Postes utilizando como archivo de referencia la cartografía digital de un 

tramo de la ciudad de Cuenca llamado C*.dgn ubicado en la siguiente 

dirección “C:\Csig*\CARTO”. 

 

• Realizar el ingreso de Atributos de Postes y realizar las diferentes consultas. 

• Al final de la práctica realizar una impresión de al menos cuatro diferentes 

consultas realizadas y pegarlas en un documento de Word con el nombre de 

Ejercicio_4. 

 
4.11 Conclusiones. 
 
En este capítulo hemos aprendido el concepto de una célula, para que sirve, como 

se crea y como se la utiliza, también hemos reforzados los conocimientos 

aprendidos en los capítulos anteriores, como el de crear un nuevo archivo 

configurar las unidades de trabajo y la creación, ingreso, y consulta de datos. 
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CAPITULO 5. DIBUJOS DE PRECISIÓN. 

 
 
Ubicación temática. 
 
En esta práctica el objetivo es de conocer la herramienta “Key-in” que significa 

entrada de comandos mediante el teclado pudiendo así aprender a hacer dibujos de 

precisión con comandos como por ejemplo: Dx, xy, co. 

 
5.1 Creación de un archivo DGN. 
 

Primero vamos abrir Microstation v8.3 dando doble clic sobre el icono  el cual nos 

va a presentar la siguiente ventana: 

 

 
Figura 5.1: Creación de un archivo DGN.  

 

En la cual vamos a dar clic en el icono de “New File” el cual nos va a desplegar otra 

ventana: 

 

 
Figura 5.2: Creación de archivo DGN. 
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Entonces vamos a poner el nombre de esta práctica como “Practica_5”, en “Tipo” 

nos fijamos que este “MicroStation DGN Files (*.dgn)” y en “Seed” la ubicación en la 

cual vamos a guardar nuestro archivo y pulsamos el botón guardar luego 

seleccionamos el archivo “Practica_5” y pulsamos en el botón “Abrir”. 

 

5.2 Configuración de las unidades de trabajo. 
 
Seleccionamos de la barra de menú “Settings > Desing File…” y se nos va abrir la 

siguiente ventana en la cual seleccionamos “Working Units”. 

 

 
Figura 5.3: Configuración de unidades de trabajo. 

 

En “Master unit” verificamos que este en “metros” y en “Label” “m.” en “Sub Unit” 

verificamos que este en “centimeters” y en “Label” “cm.”, si no lo esta lo cambiamos 

y en “Advanced Settings” damos un clic en el botón de “Edit” y pulsamos “Ok” y se 

va a parecer la siguiente ventana en la cual cambamos “100 por metro”. 

 

 
Figura 5.4: Configuración de unidades avanzadas. 

 

Y pulsamos en “Ok” y en “Ok”, luego escogemos de la barra de menú “File > Save 

Settings” con lo cual vamos a dejar configuradas las unidades de trabajo sobre las 

cuales vamos a trabajar en nuestro documento; es importante que sigamos este 

procedimiento siempre antes de empezar a trabajar. 

 



 59 

5.3 Dibujo de precisión mediante teclado. 
 
Para poder hacer un dibujo de precisión vamos a ingresar las coordenadas 

mediante teclado para esto vamos a utilizar la herramienta “Key-in”, si no se 

encuentra visible vamos a encontrarla en el menú “Utilities > Key-in” con la cual 

vamos a poder dar comandos desde el teclado. 

 

 
Figura 5.5: Herramienta Key-in. 

 

5.4 Ingreso de un polígono de seis vértices dadas sus coordenadas. 
 

Una vez visualizada la herramienta “Key-in” vamos a hacer un dibujo de precisión 

de un polígono con coordenadas las cuales van a ser los siguientes: 

 

Nº Punto Coordenadas en “x” y “y” 

Primer punto 100,100 

Segundo punto 150,150 

Tercer punto 200,250 

Cuarto punto 250,100 

Quinto punto 175,50 

Sexto punto 150,50 

Tabla 5.1: Puntos de Coordenadas. 
 

Para lo cual seguiremos el siguiente procedimiento, una vez hecha visible la 

herramienta “Key-in” vamos a seleccionar de la paleta de herramientas la 

herramienta “SmartLine”  y vamos seleccionar el color desde la herramienta 

“key-in” digitando el siguiente comando “co=31” y pulsamos luego la tecla “Enter”.  

 

 
Figura 5.6: Selección de color. 
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Entonces vamos a poder ver que el color cambia automáticamente. 

 

 
Figura 5.7: Color 31. 

 

De ahí vamos a cambiar el ancho de la línea utilizando el siguiente comando “wt=3” 

y pulsamos la tecla “Enter”. 

 

 
Figura 5.8: Selección de ancho de línea. 

 

Y vamos a poder ver que el grosor de la línea cambia. 

 

 
Figura 5.9: Grosor 3. 

 

Luego empezamos a ingresar el primer punto así mismo por teclado con el 

comando “xy=150,150” y pulsamos la tecla “Enter”. 

 

 
Figura 5.10: Ingreso de la primera coordenada. 

 

Con lo cual vamos a poder ver el primer punto. 

 

  
Figura 5.11: Visualización del primer punto. 
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Entonces vamos a seguir con el ingreso de la siguiente coordenada así mismo 

xy=200,150 y pulsando la tecla Enter. 

 

 
Figura 5.12: Visualización del segundo punto. 

 

Entonces continuamos ingresando las siguientes coordenadas hasta terminar, 

cuando ya hayamos ingresado la última coordenada vamos a ingresar por último la 

primera coordenada de la misma manera “xy=150,150” y pulsamos la tecla “Enter”, 

y vamos a poder ver ya el polígono cerrado. 

 

 
Figura 5.13: Polígono. 
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5.5 Ingreso de un círculo a partir de la herramienta “Key-in”. 
 
Para dibujar un circulo  primero vamos a cambiar el color con el comando “co=3”, el 

ancho de la línea con “wt=2” y vamos seleccionar desde el teclado la herramienta 

“Place Circle” introduciendo el comando “place circle” y pulsando “Enter”. 

 

 
Figura 5.14: Selección de la herramienta Place Circle desde teclado. 

 
Luego vamos ingresar las coordenadas del centro del circulo con el comando 

“xy=300,300” y por último vamos ingresar el radio del circulo con el comando 

“dx=50” y pulsamos la tecla “Enter” con lo que vamos a poder ver el circulo 

dibujado. 

 

 
Figura 5.15: Circulo desde teclado. 

 

5.6 Ingreso de un polígono con medidas a partir de la herramienta “Key-in”. 
 
Para ingresar un polígono con medidas primero vamos a escoger el color de la 

línea con el comando “co”, el ancho de la línea con el comando  “wt”, escogemos la 

herramienta así mismo desde el teclado con el comando “Place Block” y pulsamos 

“Enter”, luego ingresamos las coordenadas en las cuales queremos que se ubique 
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el vértice inferior izquierdo con el comando “xy” y damos las medidas del polígono 

utilizando el comando “Dx=30,20” y pulsamos la tecla “Enter” y podremos ver como 

se dibuja el polígono de cuatro lados con medidas. 

 
Figura 5.16: Polígono de cuatro lados desde teclado. 

 

5.7 Ejercicio de evaluación. 
 

• Crear un archivo llamado Ejercicio_5.dgn y realizar un dibujo de precisión de 

un polígono utilizando la herramienta “Key-in” con un color 20, grosor de la 

línea 4 y con las siguientes coordenadas:    

 

Nº Punto Coordenadas en “x” y “y” 

Primer punto 100,100 

Segundo punto 150,150 

Tercer punto 200,150 

Cuarto punto 250,100 

Quinto punto 180,50 

Sexto punto 120,60 

Tabla 5.2: Puntos de coordenadas “Ejemplo_5”. 
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• Realizar un dibujo de precisión de un círculo con la herramienta “Key-in” de 

color 4, ancho de la línea 2 con las coordenadas 200,200 como centro y un 

radio de 100. 

• Realizar un dibujo de precisión de un polígono de cuatro lados utilizando la 

herramienta “Key-in” de color 70, grosor de línea 5 de ancho largo 50 y alto 

20 y en las coordenadas 100,300. 

 

5.8 Conclusiones. 
 
Después de haber terminado esta práctica hemos conseguido conocer la 

herramienta “Key-in” que nos permitió hacer dibujos de precisión usando los 

diferentes comandos que se necesitan para la construcción de los mismos.   
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CAPITULO 6. MANIPULACIÓN DE CARTOGRAFÍA DIGITAL, UNIR DOS 

ARCHIVOS DE CARTOGRAFÍA. 
 
 
Ubicación temática. 
 
En esta práctica vamos a aprender a unir dos o más archivos de cartografía digital 

trabajando sobre archivos de referencia, además que aprenderemos también el uso 

de cercados y el uso de la herramienta copiar. 

 
6.1 Creación de un archivo DGN. 
 

Primero vamos abrir Microstation v8.3 dando doble clic sobre el icono  el cual nos 

va a presentar la siguiente ventana: 

 

 
Figura 6.1: Creación de un archivo DGN.  

 

En la cual vamos a dar clic en el icono de “New File” el cual nos va a desplegar otra 

ventana: 
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Figura 6.2: Creación de archivo DGN. 

 

Entonces vamos a poner el nombre de esta práctica como Practica_6, en “Tipo” nos 

fijamos que este “MicroStation DGN Files (*.dgn)” y en “Seed” la ubicación en la 

cual vamos a guardar nuestro archivo y pulsamos el botón “Guardar” luego 

seleccionamos el archivo “Practica_6” y pulsamos en el botón abrir. 

 

6.2 Configuración de las unidades de trabajo. 
 
Seleccionamos de la barra de menú “Settings > Desing File…2” se nos va abrir la 

siguiente ventana en la cual seleccionamos “Working Units”. 

 

 
Figura 6.3: Configuración de unidades de trabajo. 

 

En “Master unit” verificamos que este en “Meters” y en “Label” “m.” “Sub Unit” 

verificamos que este en “centimeters” y en “Label” “cm.” y en “Advanced Settings” 

damos un clic en el botón de “Edit” y pulsamos “Ok” y se va a parecer la siguiente 

ventana en la cual cambamos “100 per Meter”. 

 



 67 

 
Figura 6.4: Configuración de unidades avanzadas. 

 

Y pulsamos en “Ok” y en “Ok”, luego escogemos de la barra de menú “File > Save 

Settings” con lo cual vamos a dejar configuradas las unidades de trabajo sobre las 

cuales vamos a trabajar en nuestro documento; es importante que sigamos este 

procedimiento siempre antes de empezar a trabajar. 

 

6.3 Traer dos archivos de referencia. 
 

Para poder unir dos archivos de referencia vamos a traer dos archivos solo como 

de referencia de un tramo de la cartografía digital de Cuenca para lo cual 

escogemos de la barra de menú “File > Reference” y de la ventana que se 

despliega seleccionamos “Tools > Attach” como se muestra en la figura 6.5. 

 

 
Figura 6.5: Archivos de referencia. 

 

Y seleccionamos el siguiente archivo “C*.dgn”, “C.*dgn” y pulsamos en el botón 

“Abrir” y luego pulsamos el botón “Ok” y cerramos la ventana, con la herramienta 

“Fit View”  nos posicionamos sobre los archivos de referencia y con la 

herramienta “Zoom” podemos hacer un acercamiento. 
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Figura 6.6: Archivos de referencia C08-03, C08-04 

 
6.4 Uso de cercados. 
Para poder unir dos o más archivos de cartografía una vez traídos los archivos de 

referencia, vamos a utilizar un cercado que esta es una herramienta que nos va a 

poder permitir manipular un archivo como colocar, copiar, modificar y borrar su 

contenido. 

 

 
Figura 6.7: Herramientas cercado. 

 

6.5 Uso de la herramienta “Place Fence”. 
 
Ahora vamos a utilizar de las herramientas de cercado la herramienta “Place 

Fence” ,  dando un clic sobre su icono se va aparecer la ventana de opciones de 

esta herramienta la cual la ilustramos en la figura 6.8. 
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Figura 6.8: Ventana de opciones de la herramienta “Place Fence”. 

 

En esta ventana vamos a modificar sus opciones en “Fence Type” que significa el 

tipo de cercado que vamos a utilizar en este caso “Circle” y “Fence Mode” que 

significa modo de cercado lo vamos a dejar en “Incide”, para que nos quede de la 

siguiente manera. 

 

 
Figura 6.9: Modificación de opciones de la herramienta “Place Fence”. 

 

Una vez modificadas las opciones de la herramienta vamos a dibujar un cercado en 

los archivos de referencia de la siguiente manera, justo donde se unen los dos 

archivos de referencia que se delimitan con una línea celeste. 

 

 
Figura 6.10: Cercado. 

 

 



 70 

6.6 Uso de la herramienta “Copy”. 
 
Ahora vamos a utilizar la herramienta “Copiar” que nos va a permitir copiar y unir los 

dos archivos. 

 

 
Figura 6.11: Herramienta copiar. 

Seleccionamos la herramienta “Copiar” , y luego se nos va a aparecer la 

ventana de opciones de esta herramienta en la cual verificamos que las opciones 

sean las siguientes. 

 

 
Figura 6.12: Ventana de herramienta “Copiar”. 

 

Luego vamos a dar un clic en el cercado como se muestra a continuación. 

 

 
Figura 6.13: Ventana de herramienta “Copiar”. 
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Luego utilizando la herramienta “Key-in” que significa entrada por teclado, vamos a 

asignar la entrada de precisión que en este caso puede ser de “Dx=0,0” el cual va a 

ser el punto de origen, siguiendo con el procedimiento vamos a quitar los archivos 

de referencia dando clic sobre el icono “Referentes”  que nos va desplegar la 

siguiente ventana en la cual vamos a quitar los “Chekcs” en la opción “Display” y 

cerramos la ventana. 

 

 

 
Figura 6.14: Apagar archivos de referencia. 

 

De esta manera vamos a poder visualizar el nuevo archivo DGN creado a partir de 

la unión de dos archivos de cartografía de referencia. 
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Figura 6.15: Nuevo archivo DGN. 

 

 

6.7 Ejercicio de evaluación. 
 

• Crear un archivo de trabajo llamado Ejercicio_6.dgn y unir tres archivos de 

cartografía digital de Cuenca utilizando los archivo “C*.dgn”, “C*.dgn”, 

“C*.dgn”. 
 

6.8 Conclusiones. 
 
Conseguimos unir dos o más archivos de cartografía digital en un solo archivo, 

además reforzamos los conocimientos de uso de cercado y aprendimos a utilizar la 

herramienta copiar. 
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CAPITULO 7. MACROS 

 
 

Ubicación temática. 
 
En este capítulo aprenderemos el uso de macros en microstation con la 

herramienta llamada “Microstation BASIC”, aquí aplicaremos conocimientos básicos 

de Visual Basic con microstation, utilizando procedimientos básicos de 

programación los cuales vamos a asignar a teclas de función. 

 

7.1 Creación de un archivo “DGN”. 
 
Como en los capítulos anteriores vamos a empezar este capítulo creando un 

nuevos archivo “DGN”, el cual lo vamos a llamar “Practica_7.dgn”, para lo cual 

vamos a abrir microstation dando doble clic sobre el icono , de aquí e nos abrirá 

la siguiente ventana en donde vamos a dar clic sobre el botón de “New File”. 

 

 
Figura 7.1: Creación archivo “*.DGN”. 

 
En el cual se va a desplegar la siguiente ventana, en la cual asignaremos el nombre 

del archivo como “Practica_7”, revisamos que en “Tipo” se encuentre “MicroStation 

DGN Files (*.dgn)” y en “Seed” verificamos el lugar en donde se va a guardar 

nuestro archivo creado, luego damos un clic en “Guardar” y damos un clic en 

“Abrir”. 
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Figura 7.2: Abrir archivo “Practica_7.dgn”. 

 
7.2 Configuración de Unidades de trabajo. 
 
Ahora vamos a configurar las unidades de trabajo sobre cual vamos a trabajar, para 

lo cual seleccionamos de la barra de menú “Settings > Desing File…”, con lo cual 

se abre la siguiente ventana. 

 

 
Figura 7.3 Unidades de trabajo. 

 
De esta ventana seleccionamos “Working Units” y en “Linear Units” verificamos que 

en “Master Unit” se encuentre “Meters” en “Label” “m.” y en “Sub Unit”  

“Centimeters” en “Label”  “cm.” si no lo esta las cambiamos, luego damos un clic 

sobre el botón “Edit”  en “Advanced Settings” y pulsamos en “Ok”, se va a desplegar 

la siguiente ventana. 

 

 
Figura 7.4: Configuración de unidades avanzadas. 
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En “Resolution” de esta ventana cambiamos a “100 per Meter”, luego pulsamos en 

el botón “Ok” y “Ok”, para que se queden grabadas nuestras configuraciones es 

importante no olvidar grabar los cambios por lo que escogemos de la barra de 

menú “File > Save Settings”, y así quedaran configuradas y guardadas nuestras 

unidades de trabajo. 

 

7.3 Creación de un macro. 
 
En microstation un macro nos va a servir para que procedimientos que se tengan 

que realizar con mucha continuidad se han más fáciles de hacer, ya que estos 

procedimientos van a estar asignados a teclas de función tales como “Shift F1” o a 

otras, para la creación de un macro vamos a seguir el siguiente procedimiento, 

escogemos de la barra de menú “Utilities > Macro > MicroStation Basic”. 

 

 
Figura 7.5: MicroStation Basic. 

 
Con esta herramienta vamos a crear los macros aplicando rutinas básicas de 

“Visual Basic”, continuado con la práctica dando un clic en “MicroStation Basic” se 

va abrir la siguiente ventana. 
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Figura 7.6: Macros. 

 
En la cual vamos a poder observar macros ya creadas, lo que a nosotros nos 

interesa va a ser como crear una nueva macro con lo que en esta ventana vamos a 

pulsar el botón “New”, en la ventana que se nos abre va a ser en la cual vamos a 

ingresar los comandos, como nueva macro vamos a generar una que se denomine 

“color_rojo” y la vamos a hacer de la siguiente manera como se indica en la figura 

7.7. 

 

 
Figura 7.7: Generación de un macro. 

 

Entonces para verificar que nuestro macro este funcionando vamos a dar clic en el 

botón “Play”  verificando que el color cambia en la paleta de colores, una vez 

certificado que nuestro macro este funcionando procedemos a guardar este macro 

pulsando en la ventana de “BASIC Editor” “File > Save”. 
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Figura 7.8: Guardar el macro. 

 
Con lo que en la siguiente ventana vamos a poner el nombre de este macro como 

“color_rojo”  y grabamos. Ahora vamos a crear un macro para cambiar el ancho de 

línea siguiendo el mismo procedimiento, pulsamos en el botón “New” de la ventana 

“Macros” y vamos a digitar la siguiente sub rutina. 

 

Sub Main 

 

     MbeSendCommand "wt=4" 

     

End sub    

 

La probamos y la guardamos como “ancho_linea4”. De esta manera vamos ir 

creando macros según se presente la necesidad, por ejemplo si necesitamos 

utilizar un dibujo como el de un cuadrado de color verde, de dimensiones de 2 por 2 

grosor de línea 5 en varias ocasiones, para no estar seleccionando siempre estos 

atributos podemos generar un macro con lo que solo le asignamos a ese macro una 

tecla de función con lo cual vamos a facilitarnos el trabajo, para crear un cuadrado 

como el mencionado antes vamos a crear dos macros, el primero que se 

seleccionara el color, el ancho y la herramienta “Place Block” que lo llamaremos 

“cuadrado” y el segundo que nos dará las dimensiones del mismo, que se llamará 

“dimensión” y para eso seguimos el siguiente procedimiento como lo indica en la 

figura 7.9 y 7.10.  
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Figura 7.9: Macro “cuadrado” 

 

 
Figura 7.10: Macro “dimension” 

 
7.4 Asignación de un macro a una tecla de función. 
 
Para la asignación de un macro a una tecla de función seleccionamos de la barra 

de menú “Workspace > Function Keys…”   

 
Figura 7.11: Teclas de función. 
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Entonces se nos va a abrir la siguiente ventana en donde seleccionamos primero la 

tecla de función a la cual deseamos asignar el macro, luego digitamos la palabra 

“macro”, seguida con un espacio el nombre del macro que queremos asignar y 

damos un “Enter”, luego continuamos asignando los macros creados anteriormente 

y pulsamos el botón “Aceptar”, con la cual se que dará asignado nuestro macro a 

una tecla de función, en este caso vamos a asignar las teclas de función de la 

siguiente manera. 

 

Macro Tecla de Función 

color_rojo F9 

ancho_linea4 F8 

cuadrado F1 

dimension F2 

Tabla 7.1: Asignación de un macro a una tecla de función. 
 

 
Figura 7.12: Asignación de un macro a una tecla de función. 

 
Ahora vamos a probar las teclas de función pulsando las mismas y probamos el 

macro “cuadrado” y “dimension” primero pulsamos la tecla de función F1 con lo que 

vamos a ver que el color, el ancho de línea cambian además se selecciona 

automáticamente la herramienta “Place Block” luego con el ratón seleccionamos el 

punto de origen del cuadrado y pulsamos la tecla de función F2 y vamos a poder 

observar que se dibuja el cuadrado que se necesitaba. 
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Figura 7.13: Teclas de función “cuadrado” y “dimension”. 

 
Luego vamos a probar los siguientes macros para lo cual seleccionamos la 

herramienta “Smartline” y luego pulsamos las teclas de función F9 y F8, vamos a 

ver como automáticamente cambian el color y el ancho de la línea con los cuales 

vamos a dibujar en adelante, tenemos que tomar en cuenta que los macros van a 

quedar grabados en Microstation por lo que en otras prácticas de igual manera 

quedarán asignadas las teclas de función a los macros creados por nosotros. 

 

 
Figura 7.14: Teclas de función “color_rojo” y “ancho_linea4”. 
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7.5 Ejercicio de evaluación. 
 

• Crear un archivo llamado Ejercicio_7. 

• En el archivo crear 4 macros y asignar a sus respectivas teclas de función. 
 

7.6 Conclusiones. 
 
Hemos aprendido a crear macros y asignarles a teclas de función, con lo que se 

nos facilita el trabajo con la cartografía, ya que es más fácil y más rápido pulsar una 

tecla de función para escoger una herramienta ya configurada, que seleccionarla 

paso a paso. Así mismo, es más rápido escoger un color o un ancho de línea con 

teclas de función ya definidas de antemano. 
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CAPITULO 8. CONCLUSIONES 

 
 

Se ha conseguido sistematizar los procedimientos para la generación y edición de 

cartografía digital utilizando una herramienta CAD (Computer Aided Desing) 

Microstation v8.3, mediante 7 prácticas tutoriadas, que pretenden apoyar 

didácticamente a los estudiantes en el aprendizaje de los Sistemas de Información 

Geográfica. En este trabajo se ha utilizado cartografía digital local de la ciudad de 

Cuenca para que, por medio de ejemplos, puedan apropiarse de los conocimientos 

relativos a la edición y generación de cartografía, cumpliendo así el objetivo de que 

cada alumno auto aprenda y de que el maestro cumpla un rol de guía. 

 

Con este tutorial se puede conocer el uso del entorno de Microstation para poder 

modelar digitalmente los problemas territoriales y así contribuir a la toma de 

decisiones.  El trabajo esta dividido en siete prácticas, cada una de ellas enseña al 

estudiante a desarrollar diferentes tipos de aplicaciones, relacionadas con 

problemas de la planificación y gestión del territorio. 

 

Se ha conseguido utilizar la herramienta CAD para llevarle a niveles cercanos a los 

de un Sistemas de Información Geográfica, sirviendo por tanto de preámbulo para 

entender la lógica de un SIG. Siendo en algunos casos, el uso de cartografía digital 

por medio de un CAD, suficiente para resolver múltiples problemas del mundo real, 

obviando el uso de sistemas más complejos como los SIG. 
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	Introducción
	El objetivo es desarrollar un tutorial para el aprendizaje de la cartografía digital, por medio de información local y el software CAD Microstation, que permita contribuir, con este recurso didáctico, a los análisis de los sistemas de información espa...
	El presente trabajo pretende guiar al estudiante o a cualquier persona que independientemente quiera tener conocimientos iniciales de los sistemas de información geográfica, manejados desde una herramienta CAD (Computer Aided Desing), ya que en la act...
	La metodología utilizada de este trabajo se desarrolla por medio de un tutorial que esta dividido en 7 prácticas, las cuales son:
	La primera va a tratar temas que nos permita  familiarizarnos con la interfaz y controles principales del Microstation.
	La segunda realizaremos un inventario vial en la cual aprenderemos a crear un archivo, configurar unidades de trabajo, creación de niveles, ingreso de datos y consulta a una tabla.
	La tercera realizaremos un inventario de predios en la cual aprenderemos a utilizar herramientas de medición, crear niveles y reforzaremos lo aprendido en el capítulo 1.
	La cuarta aprenderemos a crear células mediante un inventario de postes.
	La quinta realizaremos una práctica sobre como hacer dibujos de precisión.
	La sexta aprenderemos sobre como unir dos o mas archivos de cartografía digital creando así un nuevo archivo de cartografía.
	La séptima que aprenderemos como crear un macro.
	CAPITULO 1. INTRODUCCIÓN A  MICROSTATION V8.3.
	Ubicación temática.
	En esta práctica vamos a tratar temas que nos van permitir familiarizarnos con la interfaz y los controles principales para el manejo de la cartografía digital en Microstation, así mismo vamos a trabajar con elementos básicos como los que son los cont...
	CAPITULO 2. CREACIÓN DE ELEMENTO BÁSICO LÍNEAS A PARTIR DE CARTOGRAFÍA DIGITAL DE LA CIUDAD DE CUENCA:
	Ubicación temática.
	En la Figura2.9 seleccionamos en está ventana “Tools” > “attach…” damos un clic en “TODO” y abrimos, luego pulsamos en “Ok” entonces el archivo “TODO.dgn” va a aparecer pero solo como archivo de referencia, para poder trabajar sobre el damos clic sobr...
	Una vez escogida la herramienta vamos a dejar las opciones de esta en default.
	2.7 Dibujar calles.
	La primera calle que vamos a construir es la calle Gran Colombia entre Calle Quinta y Padre Aguirre dando un clic izquierdo en la esquina de la calle y seguimos con el ratón hasta la otra esquina que damos otro clic izquierdo, para finalizar la constr...
	De la misma manera seguimos construyendo las siguientes calles pero debemos tomar en cuenta que en el momento de construir las líneas, queden unidas verificando con el siguiente indicador, que es que el puntero del ratón que cambia al momento que qued...
	Figura 2.16: Indicador de unión entre líneas
	Seguimos construyendo hasta que nos queden las calles dibujadas de la siguiente manera como se muestra en la Figura 2.17
	En donde vamos a pulsar el botón “Add” en “Sets” y ponemos como nombre “Inv_vial” luego vamos a agregar los atributos de la tabla en “Add” en “Tags” y vamos a ir creando los atributos de la tabla de la siguiente manera:
	Figura 2.19: Creación de atributos.
	En “Tag name” ponemos el nombre del atributo, en “Prompt” ponemos la descripción de que tenemos que ingresar, en “Type” el tipo de valor a ingresar y quitamos el “Check” en “Display Tag” como se muestra en la figura 2.19, luego continuamos con el rest...
	Para empezar a ingresar los datos vamos a seleccionar de la paleta de herramientas la herramienta “Atach Tags”   y vamos a seleccionar la vía dando un clic de la siguiente manera como se indica a continuación en la Figura 2.21:
	Ubicación temática.
	3.1 Creación del archivo Practica_3.
	Abrimos Microstation v8.3 dando doble clic sobre el icono   en donde se va a presentar un cuadro de dialogo en el cual vamos a crear un nuevo archivo de trabajo dando clic en el icono “New file” como se indica en la Figura 3.1
	En la Figura3.9 seleccionamos en está ventana “Tools > attach…” damos un clic en “C*” y abrimos, luego pulsamos en “Ok” entonces el archivo “C*.dgn va a aparecer pero solo como archivo de referencia, para poder trabajar sobre el damos clic sobre fit v...
	Una vez escogida la herramienta vamos a dejar las opciones de está en default y empezamos a dibujar los predios como en la figura 3.15, Damos un clic con el botón izquierdo en un lote y continuamos dando clic derecho rodeando el lote hasta que quede c...
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	Figura 3.24: Creación de atributos.
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	3.9 Ingreso de datos a una tabla.
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